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AIC2 
Additional Injector Controller 

 
 
Description: 
 

The AIC2 Additional Injector Controller provides a convenient way to inject additional fuel on an 
internal combustion engine.  It is intended primarily for use with engines that have been converted to 
forced induction with the addition of a turbo or supercharger.  It is a particularly effective way to add 
fuel on direct injected engines. 
 
The AIC2 comes in two versions.  The AIC2-P has two internal 4-bar pressure sensors.  It can be 
configured for absolute, gauge or differential measurement.  One of the sensors can also be used for 
elevation compensation.  The AIC2-V version does not have internal pressure sensors and uses an 
external voltage to determine engine load.  
 
The AIC2 can control between one and eight high impedance injectors.  It can also be configured to 
drive one or two low impedance injectors.  All injectors are batch fired according to a pulse width map 
table which features user-definable row and column breakpoints for load and RPM. 
 
The AIC2 is programmed over a USB interface with the TunerPro RT engine management software. 
Bin files contain program data.  Xdf definition files configure the user interface.  Adx files configure 
data acquisition for real-time display and logging.  Example bin, xdf and adx files are available at 
www.splitsec.com.  
 
An extremely versatile tach input is compatible with most engine speed signals.  User definable pre-
scaler and post-scalers produce an accurate tach reading on virtually any engine.  The number of 
injection pulses per engine cycle are selectable between one and eight. 
 
There are calibration tables for each pressure sensor as well as three voltage inputs.  These tables 
perform sensor linearization and unit conversion.  There are compensation tables for air temperature, 
elevation and injector dead time. 

 
Features: 
 
• Two internal 4-bar map sensors 

• USB interface 

• Real-time programmable 

• Tach pre-scaler to work with wide range of inputs 

• User selectable number of injection pulses per engine cycle 

• Drives between one and eight injectors 

• Four 2-dimensional injection pulse width map tables 

• User definable table breakpoints 

• External input for map switching 

• Laptop programmable with TunerPro RT software 

• Compensation for air temp, elevation and injector dead time 
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Versions: 
 

AIC2-P 
 

The AIC2-P has two internal 4-bar pressure sensors called PT1 and PT2.  These sensors can be 
configured to produce absolute, gauge or differential pressure readings.  PT2 can be used to generate 
a reference signal for elevation compensation. 
 

 
 
 
 
 
 
 
 
 
 
 
AIC2-V 
 

The AIC2-V does not have internal pressure sensors.  An external 0-5 V signal is used as the load 
signal. 
 
 

 
 
 
 
 
 
 
 
 
Ordering Options: 
 
The complete part numbers for the two standard versions of the AIC2 are: 
AIC2-P21, Pressure mode, two injector connectors, EV1 style 
AIC2-V21, Voltage mode, two injector connectors, EV1 style 
 
EV1 and EV6 Injector connectors with 24” pigtails are available and may be used by the user to 
modify the harness.  Each internal injector driver can run up to four high impedance injectors. 
 

 

PT1 

mini-USB 
and 

status LED 
behind 

hole cover 

AIC2-P 
wire 
harness 

PT2 

mini-USB 
and 

status LED 
behind 

hole cover 

AIC2-V 

wire 
harness 
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Wire Assignments: 
 

 LABEL CONNECT TO Wire gauge WIRE COLOR 

BATT+ Battery positive (switched +12 V) 18 Red 
BATT- Battery negative (chassis ground) 18 Black 
SIG GND ECU signal ground 20 Black/yellow 
TACH Engine speed signal 20 Yellow/black 
VIN External load voltage input (optional) 20 Green 
IAT Air temp sensor (optional) 20 Gray 
AFR External AFR meter 20 Yellow 
MAP SW Switch to ground to select table B 20 Brown 
RELAY Low side of relay coil 20 Orange 
INJ+ (2) Injector plug positive (B+) 20 Red 
INJ- (DR1) Injector plug negative (driver 1) 20 Tan 
INJ- (DR2) Injector plug negative (driver 2) 20 Tan/Black 

 
 

Connections: 
 

BATT+ (Red) 
 

Connect to a switched, fused source of +12 V.  This connection powers the unit and all the additional 
injectors it controls. 
 

BATT- (Black) 
 

Connect to a power ground connection.  Chassis ground is frequently used.  This connection carries 
the load current for all injectors.  
 

SIG GND (Black/yellow) 
 

Connect to the sensor ground for the stock ECU.  This connection is critical for accurate sensor 
measurements for VIN, IAT and AFR.  Connection to chassis ground will degrade accuracy and may 
induce noise. 
 

TACH (Yellow/black) 
 

Connect to a signal that is proportional to engine speed.  Examples of suitable signals include coil 
primaries, injector drives, cam sensors and crank sensors.  The tach pre-scaler will be set to divide 
the pulse rate of the tach signal down to the engine cycle rate.  The engine cycle rate is the cam rate 
on a 4-stroke engine and the crank rate on a 2-stroke engine.  Do not connect to 5 V coil triggers. 
 

VIN (Green) 
 

Connect to an external load signal when not using the internal map sensor(s).  This input may be 
connected to an external map sensor, MAF sensor or other 0-5 V load signal.  This input may be 
referred to as Vin1 or Vin1/PT3. 

 
IAT (Gray) 
 

Connect to an IAT (intake air temp) sensor.  This input may be connected to the signal from an 
existing IAT sensor or used with a dedicated sensor.  When used with a dedicated sensor, the AIC2 
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can be configured to provide the necessary 1 kΩ pull-up resistor to 5 V.  The IAT signal is generally 
used for air temperature compensation.  This input may be referred to as Vin2 or Vin2/IAT. 
 

AFR (Yellow) 
 

Connect to the 0-5 V output from an external AFR meter.  The xdf has a calibration table that can be 
used to display the 0-5 V signal as true air/fuel ratio.  The AFR input can alternately be used for 
compensation.  This input may be referred to as Vin3 or Vin3/AFR.   
 

MAP SW (Brown) 
 

Ground this wire to switch to map table B.  If this feature is not used, this wire may be left 
disconnected.  Map switching may also be controlled by one of the comparators built into the AIC2.  
These comparators can be programmed to switch based on load and RPM. 
 

RELAY (Orange) 
 

Connect to the low side of a relay coil.  The other side of the relay coil should be connected to a fused 
source of +12 V that is switch by the ignition.  The relay is controlled by a comparator which has user 
definable signal input and threshold.  
 
INJ+ (Red) 
 

Connect to the high side of the injector(s).  The INJ+ wires provide a constant +12 V.  There are two 
INJ+ wires.  Each can supply one to four high impedance injectors or a single low impedance injector. 
 

INJ- (Tan) 
 

Connect to the low side of the injector(s).  The INJ- wires provide the variable pulse width drive by 
pulling the low side to ground to turn on injection.  There are two INJ- wires.  Each can drive one to 
four high impedance injectors or a single low impedance injector.  The tan wire is internally connected 
to driver 1. 
 

INJ- (Tan/black) 
 

Connect to the low side of the injector(s).  The INJ- wires provide the variable pulse width drive by 
pulling the low side to ground to turn on injection.  There are two INJ- wires.  Each can drive one to 
four high impedance injectors or a single low impedance injector.  The tan/black wire is internally 
connected to driver 2.  Driver 2 can be set to mirror driver 1 so that all injectors are controlled by one 
map table. 
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Wiring: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Use solder and heat shrink for the best electrical connections. 
 

• The green, gray, yellow, orange and brown wires may be left disconnected if they are not 
being used. 

 

• The 18 AWG black wire carries all the injector current and is normally connected to chassis 
ground or battery negative. 

 

• The black/yellow wire is the sensor ground wire and is tied to ECU sensor ground to preserve 
signal accuracy and minimize noise. 

 
  

PT1 

mini-USB 
and 

status LED 
behind 

hole cover 

AIC2-P 
wire 
harness 

PT2 

Connect 
to intake 
manifold 

Leave 
open to 
atmosphere 

Red 18 AWG 

Black 18 AWG 

Black/yellow 

Yellow/black 

Green 

Gray 

Brown 

EV1 

EV1 

Switched B+ 

Chassis ground 

Sensor ground 

Tach signal 

VIN signal 

IAT signal 

Ground to  
switch maps 

Up to four high impedance 
injectors can be branched 
from each driver wire pair  

Red 

Red 

Tan 

Tan/Black 

Yellow 
AFR signal 
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RELAY 
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Internal Block Diagram: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Functions: 
 
Tach Circuit 
 

The tach input has an internal threshold voltage of approximately 2.5 V.  It has a high voltage 
capability and will not be damaged by inductive spikes.  The pre-scaler is used to divide down to the 
base rate of the engine.  The base rate is the cam rate on a 4-stroke engine and the crank rate on a 
2-stroke engine.  The post-scaler is used to calculate RPM from the base rate.  Set the post-scaler to 
2 for a 4-stroke engine and to 1 for a 2-stroke. 
 

The hold-off function is used to prevent noise form disrupting the RPM reading.  When used with a 
crank or cam sensor, the hold-off function is not needed.  It is primarily intended for use with coil 
primary signals that have a lot of ringing following transitions.  A typical hold-off setting on a coil would 
be 4 ms.  Lower hold-off times must be used in high RPM applications. 
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IAT 
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Trigger Module 

PT1 Calibration 

VIN Calibration 
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External 
Trim 
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Relay 
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PT1 and PT2 
 

PT1 and PT2 are internal 4-bar pressure sensors that are included with “P” suffix units.  The precise 
calibration of these sensors yields an accurate differential pressure measurement when the PT2 
reading is subtracted from PT1. 
 

VIN 
 

The Vin1/PT3 input is the primary load input on V suffix versions of the AIC2.  It is also used among 
the options available when configuring the load selection on P suffix versions.  It can be connected to 
external MAP, MAF, TPS or other load sensors.  It can also be used in combination with the internal 

MAP sensors.  There is a provision to select a 1kΩ pull-down resistor which may be needed with 
certain MAF sensors. 
 

IAT 
 

The Vin2/IAT input is used to measure intake air temperature.  It can be connected to an existing or 

dedicated sensor.  There is a provision to select a 1kΩ pull-up resistor which is used with a dedicated 
sensor. Air temperature information is displayed on the data dash and can be logged.  It is also used 
as the input for air temperature compensation. 

 
AFR 
 

Vin3/AFR is a flexible input that can be used in various ways.  For AFR, this input is connected to the 
0-5 V output from an external AFR meter.   A true AFR reading is produced by the AFR Calibration 
table.  The air fuel ratio is displayed on the data dash and can be logged.  This input can also be used 

as an external user trim input from either a potentiometer or a 0-5 V input.  A selectable 1kΩ pull-up 
resistor is available for use with inputs that produce a variable resistance to ground. 

 
Calibration Tables 
 

There are calibration tables which are used to convert the voltage output of the pressure sensors to 
read in bar or psi.  These tables should not have to be changed.  The table for VIN can be used to 
adjust for the full-scale range of an external pressure sensor or any other 0-5 V signal.  The 
calibration table for IAT converts an IAT sensor voltage to read in degrees F or C.  The calibration 
table for AFR converts the 0-5 V output from an external AFR meter to an AFR reading. 
 

Load Source Select 
 

The load source select provides flexibility in the signal used for the load axis on the map table.  Load 
can be absolute, differential or gauge pressure based on PT1 and PT2.  Alternately load can come 
from an external voltage on Vin1, Vin2 or Vin3. 

 
Pulse Width Tables 
 

There are two pairs of 33x26 pulse width tables for injector pulse width in milliseconds.  Each driver 
has a map table A and B.  The default table is A.  Map B is selected by grounding the brown wire or 
by one of the comparator modules.  The breakpoints for rows and columns are user definable.  The 
range can be restricted to the actual RPM and pressure range of the engine to increase resolution.  
Bi-linear interpolation is used to make smooth transitions between breakpoints. 
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Compensation Tables 
 

There are three 33x1 compensation tables and one 7x1 for each driver.  These tables are for 
elevation, air temp, external trim and injector dead time compensation.  Each of these tables can be 
enabled or disabled by the user. 
 
Elevation compensation table values are factors that are multiplied by the injection pulse width from 
the main table.  These factors are adjusted to provide consistent fueling over elevation change.  
Elevation information is determined by the baro source select option.  PT2 is normally used.  When 
PT2 is left open to atmospheric pressure, its reading varies according to elevation change. 
 

Air temperature compensation table values are also factors multiplied by injection pulse width.  These 
factors provide consistent fueling as intake air temperature changes.  The air temperature reading 
requires an external air temp sensor.  This sensor may be a dedicated sensor or the existing sensor 
used by the stock ECU. 
 
The external trim tables are very flexible.  The tables are user adjustable for the types of operations 
performed such as multiplication or addition.  Each table also has a source select that allows virtually 
any source on the module to be used.  The nominal input is Vin3. 
 

The dead time compensation table is used to compensate for changes in battery voltage.  All fuel 
injectors have a dead time which is related to the turn-on and turn-off delays for the injector.  Dead 
time is the difference between the pulse width of the control signal and the actual time duration that 
the injector is on.  Injector dead time is highly dependent on battery voltage and varies widely among 
different types of injectors.  Dead time compensation table values are added to the injection pulse 
width from the main table. 
 

Trigger Module 
 

The trigger module determines how many evenly spaced injection pulses there are per engine cycle.  
The number of pulses is user-definable in software.  In cases where the injection is upstream before 
the throttle, the number of pulses should equal the number of cylinders.  When controlling port 
injectors, the number of pulses should be at least two. 
 

Pulse Generator 
 

The pulse generator produces the control signal use to drive injection.  The pulse width is the value 
from the main table modified per the compensation table values.  High impedance injectors are driven 
by a saturating drive signal.  This pulls the low side of the injectors to ground for the duration of the 
injection pulse.  Low impedance injectors are driven by a peak and hold signal which pulls to ground 
for 1 ms.  The injector is held on for the remainder of the injection pulse by a 25% duty cycle signal. 

 
Injector Drivers 
 

There are two injector drivers.  Each can drive either a single low-impedance injector or up to four 
high impedance injectors.  Be sure to select the low impedance option when driving low impedance 
injectors.  This will activate peak and hold operation of the injector driver.  When active, these drivers 
pull the low side of the injector coils to ground. 
 

Relay Driver 
 

The relay driver can be used to pull the low side of a relay coil to ground.  Activation of the relay is 
controlled by a comparator. 
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Comparator Modules 
 

The relay driver is controlled by a comparator module.  The injector drivers can also be used to drive 
general purpose loads such as a relay coil.  When driving general purpose loads, the drivers are 
controlled by the comparator modules.  These modules can be configured for a variety of signal 
inputs.  The comparators compare the signal inputs to user defined thresholds.  Switching around 
those threshold points are further controlled by user defined hysteresis. 
 
The load and RPM sections each have their own threshold and hysteresis settings.  The results from 
each of these sections are combined per a variety of boolean logic options.  The Boolean operations 
can be used to directly set the output of the comparator.  Other options include selecting the output 
from just the load or RPM sections.  A variety of logical combinations are also available including 
AND, OR, NOT and XOR. 
 
The comparator outputs can also be used to control map switching.  The Pulse Width Map Select 
parameter under Settings can be used to make map switching dependent on either comparator 1 or 2. 
 

Software: 
 

The AIC2 is programmed with the TunerPro RT engine management software.  The software can be 
downloaded for free at www.tunerpro.net.  There are two versions of TunerPro.  Be sure to download 
the TunerPro RT version which supports real-time data. We strongly recommend that you register and 
make the requested donation to support future enhancements to TunerPro RT. 
 
TunerPro RT is a very flexible and powerful user interface for engine tuning.  It uses three types of 
files to operate, xdf (definition files) bin (binary data files) and adx (data acquisition files).  Xdf files 
define the parameters that can be adjusted and their memory locations.  Bin files store the data that is 
used to tune the engine. Adx files specify the real-time data and dashboard functions. 
 
Split Second supplies the xdf, starting bin and adx files for the AIC2.  Engine tuning is accomplished 
by modifying the data stored in the bin.  Multiple bin files may be created and stored that represent 
different states of tune. 
 

Data Connection: 
 

There is a mini-USB connector behind the hole plug on the side of the unit.  Use a USB 2.0 A to mini-
B 5-pin cable to connect the unit to your laptop computer.  Later versions of Windows should identify 
the USB interface and load the correct driver.  If data communication is not established when you click 
Initialize Emulation Hardware in TunerPro RT, you must load the driver manually. 
 
Open the device manager in Windows.  When the driver is not installed, you will see an entry under 
Other Devices that reads USB <-> serial converter with a yellow warning symbol.  The required VCP 
driver can be downloaded from FTDI at http://www.ftdichip.com/Drivers/VCP.htm.  FTDI application 
note AN234 at http://www.ftdichip.com/Support/Documents/AppNotes.htm is a complete guide to 
driver installation. 
 

Status LED: 
 

There is a status LED behind the hole plug on the side of the unit.  It will pulse once per second when 
the unit has power and is operating normally. 
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Programming: 
 
Open Calibration File 
 

1) Launch TunerPro RT 

2) Select the AIC2 definition file (xdf).  Xdf files are posted at www.splitsec.com under 
downloads. 

3) If you have a bin file stored on your laptop that you plan to use, click on Open Bin to select it. 

4) If you don’t already have a bin, you can read the one out of your unit.  Click the Initialize 
emulation hardware icon. 

5) Click the download bin from emulator icon. 

6) Use Save Bin As to name and save the current bin on your hard drive 

7) If you want to save the starting bin in its current state before tuning, use Save Bin As to save 
the current bin with a different name. 

 

Customize TunerPro RT Settings 
 

1) All of the adjustments you can make are selected within the Parameter Tree menu bar on the 
left side of the screen. 

2) Select the Parameter Category View Type to group by Settings, Calibration, Mapping and 
Compensation. 

3) Use the plus sign next to each to expand your selections. 

4) All selections are either a scaler, flag or table 

a. Scalars are a numeric value and are represented by a ππππ icon.  They can be used to set 

a specific value.  They can also be used to make a selection among several options.   

b. Flags are settings used to turn options on or off. 

c. Tables are either 1D or 2D depending on their function. 

5) Hold the pointer over a parameter to see the comments that explain how to use it. 

6) Select Parameter Comments under the View menu to see comments displayed at the bottom 
of the screen whenever a parameter is selected. 

7) Double click a parameter to display that parameter window on the screen. 

8) Under Tools and Preferences, select reverse rows to configure tables so that the rows go in 
increasing or decreasing order as row value increases. 

9) Under Tools and Preferences, deselect color table cells for a white table background. 

10) Under Window, click Close All Editors to close all the scaler, flag and table windows that are 
open. 

 

Configure the bin for the Application 
 

1) There are two comparators that can be configured for map selection.  There are four main 
maps for injection pulse width, A and B for driver 1 and A and B for driver 2.  Each comparator 
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is dual channel with user definable inputs, thresholds and hysteresis.  Available inputs include 
the pressure sensors, all voltage inputs and RPM.  The comparator outputs can be used to 
select between maps A and B or between tables for driver 1 and driver 2.   
 

2) There is a dedicated dual comparator for auxiliary relay control.  In addition to control by load 
and RPM there is a start-up timer that turns on the relay for a user-definable number of counts.  
Each count is 0.1 seconds.  There are various aux relay output configurations.  Among them is 
one that can be used to turn the relay on for testing. 
 

3) The map selection section has several settings for switching from map A to map B or from 
map 1A/B to 2A/B.  In addition to comparator control, map switching can be set for control by 
grounding the brown wire. 
 

4) The load source select is used to determine the signal source for the injection pulse width 
tables.  The signal can come from multiple combinations of PT1, PT2 and VIN.  Use of PT1 as 
the load source will produce a first order compensation for elevation.  Selecting PT1-PT2 
produces a gauge pressure reading.  This provides a load reading based on pressure above 
ambient.  The choice of these two load sources depends on how the stock ECU behaves over 
elevation change. 
 

5) The baro (barometric) source select is normally set to PT2 on “P” units with internal pressure 
sensors.  Any voltage input may also be selected as a baro input. 

 
6) If you are using a dedicated IAT sensor to measure intake air temperature, select IAT pull-up 

enable to turn on an internal pull-up resistor.  If you are taping onto an existing IAT sensor for 
the stock ECU, leave that pull-up turned off. 
 

7) A pull-up resistor is also available on the Vin3/Ext trim input.  This makes it possible to use an 
external potentiometer to make fuel adjustments 
 

8) Set the tach pre-scaler to divide the tach pulse rate down to the engine cycle rate.  The engine 
cycle rate is the cam revolution rate for a 4-stroke engine and the crank revolution rate for a 2-
stroke engine. Changes to the pre-scaler setting take effect after the power to the unit is 
cycled off and on. 

 
9) The pre-scaler allows a wide variety of signals to be used to for the tach input.  These signals 

include crank sensor, cam sensor, coil trigger and injector signals.  The table below shows a 
variety of examples and how to set the pre and post scaler values.  There are lots of 
possibilities.  This table is intended to give a feel for how to set the pre-scaler and post-scaler 
values. 

 

 
 

10) Set the tach post-scaler to two for a 4-stroke and one for a 2-stroke engine. 

Engine Signal Description Pre-scaler Post-scaler 

4-stroke Crank 12 tooth encoder wheel 24 2 
4-stroke Cam 4 tooth encoder wheel 4 2 
4-stroke Ignition True sequential coil trigger 1 2 
4-stroke Ignition Wasted spark coil pack 2 2 
4-stroke Injector True sequential injector 1 2 
2-stroke Crank 3 tooth encoder wheel 3 1 
2-stroke Crank 1 tooth encoder 1 1 
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11) Use the Tach Holdoff Time to prevent noisy signals form creating an erratic RPM reading. 

 
12) There are separate settings for external trim on drivers 1 and 2.  These settings select the 

sources and modes used for the external trim tables.  The modes available are off, direct, 
multiply and offset. 
 

13) The Pulses per Engine Cycle setting depends on the location of the additional injector(s).  If 
the injector(s) are used upstream before the throttle body, the number of pulses should equal 
the number of cylinders.  If the AIC2 is being used to run port injectors, it is normally set to two 
pulses per cycle.  A setting of four would pulse the additional injectors four times per cam 
revolution which would provide identical fueling to all cylinders. 
 

14) Use peak hold enable for driver 1 and 2 if they are being used to drive low impedance 
injectors.  Driver 1 and 2 can be set individually.  Each driver can drive one low impedance 
injector or up to four high impedance injectors. 
 

15) Select Driver 2 Mirrors Driver 1 if you want to drive both drivers from the driver 1 PW map 
table. 
 

16) There are sensor calibration tables for PT1, PT2, Vin (external load signal), IAT and AFR.  
Each table has user definable breakpoints as well as calibration values.  In most cases the 
defaults values will not have to be changed. These table are grouped into SI, US and Volts 
Only.  Use the table in the group you are most comfortable with. 
 

a. PT1 and PT2 are 4-bar sensors. 

b. Vin1/PT3 can calibrated in equivalent pressure or by voltage 

c. Vin2/IAT can be calibrated in equivalent temperature or by voltage. 

d. Vin3/AFR can be set to match the scaling for AFR set by the external AFR meter. 

 

17) The mapping section contains the A and B maps for drivers 1 and 2.  These maps have user 
adjustable breakpoints for load and RPM.  This makes it possible to add more resolution in 
areas where you need it.  These tales can be viewed using SI units (bar), US units (psi) or in 
voltage. 

 
18) The compensation section has injector constants for driver 1 and 2.  These constants are 

nominally a value of 1.0.  Change the constant to make a global change for injector size 
 

19) There are compensation tables for elevation (ambient pressure), IAT (air temp), external trim 
and injector dead time.  Each of these tables has user definable breakpoints as well as 
calibration values.  These tables are grouped into SI, US and Volts.  Use the table in the group 
you are most comfortable with.  Each compensation table may be turned off. 
 

a. First order compensation for atmospheric pressure occurs when load is calculated as 
PT1.  In that case, you may turn off elevation compensation or use the table with less 
compensation to account for second order effects.  Injection pulse width is multiplied by 
the value in the elevation compensation table 

b. The IAT compensation table is pre-loaded with calculated values to account for 
changes in air temperature.  Injection pulse width is multiplied by the value in the 
compensation table. 
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c. The external trim table is very flexible in terms of the source and modes that are 
available.  Those options are made in the setup area. 

d. The dead time compensation table adds to the injection pulse width according to the 
values in the table to account for different battery voltages. Injector dead time varies 
widely for different injectors.  The default values are representative for a typical 
injector. 

 
Tuning 

 
1) If you are modifying an existing tune, download the current bin and use Save bin As to keep a 

copy of the starting bin should you ever need to go back to it. 

2) Verify that the load and RPM readings are correct.  If necessary, change the signal used as 
the tach input.  Adjust the tach pre-scaler and post-scaler to obtain the correct RPM reading. 

3) If the tach reading is jumpy and you are using a coil primary as the tach input, use the Tach 
Holdoff Time scalar to reject the noise following an ignition pulse.  A typical value would be 3 
ms.  

4) Any parameter that has an asterisk next to it requires a power cycle to take effect.  Note that 
the processor can be powered by the USB connection.  To cycle power, turn off the power to 
the unit and temporarily disconnect the USB connector. 

5) If you have trouble initializing the emulation hardware in TunerPro RT, turn off the power to the 
unit, unplug the USB connector, reconnect USB and turn power back on.  The preferred 
sequence is USB connection first, then power on the unit. 

6) Select the compensation tables that you want on or off. 

7) Make sure driver 2 mirrors driver 1 if you want all injectors to be driven the same way. 

8) Tune by load.  Since injection events are a multiple of RPM, fuel automatically increases with 
RPM.  That means you can start with the same pulse width for all RPM at a given pressure. 

9) Enable Acquire Data to stream data from the AIC2. That data can be observed on the Data 
List screen or the Data Dash. 

10) Enable data Tracing to see a moving highlight on selected data tables. 

11) Use click-and-drag to highlight regions of the table.  Directly fill a value or alter the values by 
using offset, multiply or divide. 

12) Use copy and paste to move table values between tables or between TunerPro RT and Excel.  
Use Tools>Custom Tools>New TunerPro Instance to have two bins open at once.  This 
simplifies copy and paste from one bin to another. 

13) Enable emulation to upload changes in real time. 

14) Save your bin for use later before closing TunerPro RT.  Use save as if you want to preserve 
the starting bin.  
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Electrical Characteristics: 
 

PARAMETER CONDITIONS MIN TYP MAX UNITS 

Supply Voltage BATT+ to BATT- 12 13.5 15 V 
Supply Current Into BATT+ terminal, no injection  16  mA 
Tach threshold  Normal operation  2.5  V 
RPM Max engine speed   20k RPM 
VIN Range Normal operation 0  5 V 
VIN Resistance To ground, Normal operation  100k  Ω 
Pressure Range PT1 and PT2 0  4 bar 
L Injector peak Initial sink current, low Ω injector   4  A 
L Injector hold Steady state sink current   1  A 
H Injector limit Max current before shutdown  6  A 
Relay Drive Max current draw   0.5 A 

 
Mechanical Characteristics: 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

1949 E. Deere Ave. 
 Santa Ana, CA  92705 

(949) 863-1359 
www.splitsec.com 

2.875  

3.000  

1.000  

3.300  

2.500  


